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Introduction

The Skill Builder DX environment is designed to meet your individual learning needs.  By providing strong instructional design in a versatile manner, Skill Builder DX courses offer an interactive learning experience to increase your skills and job performance.  

Easy course installation and a user-friendly interface allow you to quickly begin learning even if it is your first time using a Skill Builder DX course.  In addition, the Skill Builder DX learning environment offers many learning options including browser playable, downloadable, LAN-based and local workstation courses.  You will find a consistent and integrated learning experience, regardless of whether you are learning over the Internet, within a corporate intranet, from the local network in your office, a standalone computer, or laptop. 

Skill Builder DX offers learning flexibility.  You have the flexibility to choose what you learn.  An enhanced targeted learning feature allows you to execute a keyword search to locate and learn about a specific area of interest within the course.  You may also have the flexibility to choose where you learn.  Based on the installation of the courses and authorization of your Training Administrator, you may have the option of beginning a course online and at any time downloading desired sections of the course content for offline learning.  Finally, you have the flexibility to choose your learning environment.  Customized user preferences may allow you to designate the use of audio, tool tips, feedback and the interface theme within a course.     

Launching Skill Builder DX Courses

Launching Skill Builder DX Courses from Your Local Workstation

1. Click the Start button and point to Programs.

2. Point to NETg and click Skill Builder DX.

If there are multiple Skill Builder DX courses installed on your workstation, you will see the following window.

[image: image2.png]Skill Builder DX

Available Courses

len_US_72021: M5 thord 2000 Proficient User

Start Caurse. Exit





3. Select the course title you want to learn and click Start Course.

4. If prompted, type your user ID and password and click OK.

5. If you have never launched a Skill Builder DX course from this workstation and are prompted for a user ID, you will need to re-enter your password for confirmation, then choose OK.

Note:  This is the same method that is used to launch content that has been downloaded from a web server.

Launching Skill Builder DX Courses from the CD-ROM

Once a Skill Builder DX course setup program has been run on a workstation for the first time, the autoplay feature will immediately launch the course the next time you put the course CD-ROM into your CD tray.  If the autoplay feature is not enabled on your workstation, you will need to follow the same steps necessary for launching a course from your hard drive. (See Launching Skill Builder DX Courses from Your Local Workstation).
Launching Skill Builder DX Courses on the Local Area Network (LAN) 

A LAN implementation of the Skill Builder DX learning environment allows users (with appropriate network rights) on a local workstation to access courses that are installed on a file server. When Skill Builder DX courses are installed on the LAN, you can launch a course using one of the following techniques:

Log on to your Learning Management System (If you are using NETg’s LAN SkillVantage Manager, see the LAN SkillVantage Manager Getting Started Guide for more information) and select the course you would like to take from the Take Training window.

-or-

Double-click the Skill Builder DX shortcut on your computer's desktop.

 -or-

Follow the launch instructions provided by your Training Administrator.

Launching Skill Builder DX Courses in Your Web Browser

Courses may be installed on your organization's web server allowing you to launch them from your web browser.

To launch a course from Web SkillVantage Manager (see the Web SkillVantage Manager User Guide for more information about Web SVM):

1. Launch your web browser.

2. Log on to Web SkillVantage Manager.

3. On the Training Plan page, select a course title.

4. Click the Take Course button.

Start-up Options Overview

Each time you launch a Skill Builder DX course, you will see the Start-up Options screen. The links on this screen provide you with quick and easy access to the Skill Builder DX learning environment functions. The available links depend upon the method you are using to access the course, and whether you are launching the course for the first time.

Start Tutorial -'Using This Course'

Clicking this link opens a new window containing an online tutorial about how to take a Skill Builder DX course. This link only appears the first time you launch the course.

Start the Course

Clicking this link starts the first unit. You will only see this link the first time you launch the course. 

Continue Using This Course

Clicking this link takes you to the page where you last exited the course. You will only see this option when you re-enter a course where you have previously accessed the course content.

Assess My Knowledge

Clicking this link takes you to a list of available course assessments.

Fast Track to a Topic

Clicking this link takes you to an alphabetical list of all topic titles in the course. You can perform a search for a specific topic title from this list.

Download and Learn

Clicking this link to takes you to the Download screen, where you can select topics to download to your workstation. This link is only available if you are accessing the course online and your Training Administrator has authorized download capabilities.

Navigating Skill Builder DX Functions

Menu Bar

The menu bar across the top of the Skill Builder DX window includes all of the commands you need to access the learning environment features. The menu items are always available, regardless of your location in a course.

	Menu
	Description

	My Learning Track


	Options in the My Learning Track menu offer access to information related to your personalized learning track. 

	View


	Options in the View menu offer access to the contents of the course. The Course Map is arranged hierarchically, while the topic search views are arranged alphabetically. 

	Download


	Options in the Download menu offer access to the course topics available for download to your workstation. Download topics are arranged hierarchically on the Course Map and My Learning Track tabs and alphabetically on the Fast Track to a Topic tab. 

(This menu is only available when you are using a web browser to launch a Skill Builder DX course and your Training Administrator has authorized download capabilities). 

	Help
	Options in the Help menu include access to course specific help, the tutorial, help using the course, the Start-up Options screen, user preference settings, your location within the course, and Skill Builder DX properties.

	Exit
	Click on this menu option to exit the Skill Builder DX learning environment.


If you are using a course that is available in Download Only mode, the My Learning Track and View menus will not appear.  In addition, the Start-up Options screen and your location within the course will not be available on the Help menu.  After content has been downloaded, these options will be available when using the course on your local workstation.

Menu Bar Icons

Some newer courses have been created in 800x600 screen resolution.  When you are using these courses with your computer screen resolution set to 800x600, the menu bar options will appear as icons on the right side of the Control Panel (See Control Panel) instead of at the top of the window when you are viewing the course content.  When you are outside the course content, the menu bar options will still appear at the top of the screen.  The behavior of the menu bar icons is the same as the behavior of the menu bar options. (See Menu Bar).
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	My Learning Track
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Windows and Tabs

Selecting a menu item causes the content window to display a related set of tabbed pages. Once you use the menu bar or menu bar icons to display the appropriate tab set, you can navigate the content window features by clicking the tabs. 

	My Learning Track 

· Assess My Knowledge

· View My Learning Track

· View My Results
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	View Contents 

· Course Map

· Topic Index

· Fast Track to a Topic
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	Download 

· From Course Map

· From My Learning Track

· From Fast Track to a Topic
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	Help 

· User Preferences
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Control Panel

When you start a course, the Control Panel will automatically appear.  The Control Panel allows you to move through the course and access the course content. It is a moveable window, so you can place it in any position on your screen.  You can move through the course using the forward and back arrows located on the right side of the Control Panel. In addition, two menu options are available – the Page Number Indicator and the Utilities menu.

	Standard Control Panel:
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	Control Panel with menu bar icons: 
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(only visible in 800 x 600 courses viewed with 800 x 600 screen resolution)


The Page Number Indicator displays the current page number, as well as the total number of pages in the current topic. You also have the choice of moving to the next topic, the previous topic, and a specific page within the current topic.

The Utilities menu offers access to additional options.  The Print Screen option prints the current page. The Notepad option allows you to take notes about the course content and save them to a text file for future use.

If your training administrator set up a link within the course to a web page or a file on your local network, you will see a user link icon in the lower-left corner of the Control Panel. You may see one of the two following icon designs:
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	Topic Link
	Course Link


The topic link icon appears when the target of the link is relevant to the current topic only. It is only visible within the topic pages. The course link appears when the target of the link provides additional information that is relevant to all areas of the course content. It is visible on every page.
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 If more than one link is defined in a course, Skill Builder DX will display a list of each of the links in a new window. You can select the link you want to launch from this list and click the Go To button.

The Utilities menu also offers another method to access the Skill Builder DX User Preferences. (See Changing the Skill Builder DX Learning Environment). 
When you are running a course that has audio available, the audio button will appear in the upper-left corner of the narrative text box.  Clicking this button will play the audio for the current screen.  You can replay the audio as many times as you like.

The narrative text for each page appears against a white background in the Control Panel window. When you are prompted to participate in a simulation on a particular page, the Control Panel background changes to yellow. You will also see an interactivity indicator (mouse icon) in the lower-left corner of the Control Panel.

	Control Panel with Interactivity Indicator
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Taking an Assessment

Preassessments are an initial performance-based evaluation of your skills and knowledge of the course topics. A Preassessment is available for each course unit and may be taken only once.

Post Assessments are a performance-based evaluation following a unit of instruction. Post Assessments can be retaken at any time.

Starting an Assessment

1. On the Start-up Options screen, click Assess My Knowledge.

-or-

2. From the menu bar, choose My Learning Track, Assess My Knowledge.

3. On the Assess My Knowledge tab, click an assessment title to highlight it.

4. Click the Start button that appears to the right of the assessment title.

-or-

Click the Start Selected Item button.

5. Read the instructions and click the Start Assessment button.

6. Click the Page Forward button to progress through the assessment.

Reviewing Your Assessment Results

At the end of an assessment, the View My Results screen is displayed. You can display the View My Results tab at any time to see all of your assessment scores by selecting the View My Results option in the My Learning Track menu. 

To begin the assessment for the next unit of the course, click on the Start Next Assessment button. To view your personalized Learning Track, click the View My Learning Track tab.

Click the Course Map button, use the Menu Bar, or click on another tab to navigate to another screen. 

If you need additional information about this screen, click the ? button.  

Using My Learning Track

Your Preassessment results are used to create a personalized Learning Track. Only those topics where you may need additional instruction appear in your Learning Track. Each time you complete a Preassessment or Post Assessment, your Learning Track and the View My Learning Track screen is updated.  Using your personalized Learning Track allows you to focus your learning efforts and may significantly reduce your total training time.

If you are still on the View My Results tab, click the View My Learning Track tab to display your personal Learning Track.

Downloading Skill Builder DX Courses 

If you are accessing a Skill Builder DX course online and your Training Administrator has authorized it, you may be able to download topics to your workstation. To begin downloading courses:

7. Launch the course in your web browser. (See Launching Skill Builder DX Courses in Your Web Browser).

8. In the Start-up Options screen, click Download and Learn. (This will take you to the Download From Course Map tab.)

-or-

Click the Download menu and select a view from which to download course topics. (From Course Map and From My Learning Track are hierarchical views. From Fast Track to a Topic is organized alphabetically.)

9. Click the box next to the title(s) you wish to download. Items that have been started will appear with a half-full dot next to the title, while completed titles will have a full dot.  Topics that have been mastered, either by Preassessment or Post Assessment will appear with a checkmark next to the title. The size of the file(s) you select appears in the lower-right corner of the screen. If you want to download the entire course, click the Select All button.

Note:
Purple shaded boxes next to a unit, lesson, or topic indicates that content has already been downloaded. Yellow shaded boxes indicate that the online version of the course is more recent than the content that has already been downloaded.

10. You have the option of downloading the course help file along with the selected content. Check the Download Course Reference Materials option if you want to copy this file to your workstation. (After downloading, these materials can be accessed by selecting the Course Guide option from the Help menu).

11. You have the option of downloading the Skill Builder DX player help files and tutorial along with the selected content. Check the Download Skill Builder DX Help option if you want to copy these files to your workstation. (After downloading, this information can be accessed from the Help menu by selecting Quick Help for the player help files and Tutorial for the tutorial).

12. If audio is available for the course and you wish to download the audio files, click the Download with Audio button. If you do not wish to download the audio portion of the course, click the Download without Audio button.

13. If the NETg Windows Player Installation dialog box appears, specify a location on your workstation where the course files and player should be installed. (By default, they will be installed to c:\Skillb.) Click OK.

A progress window appears as the selected content is downloaded. The window displays the name and size of the file being downloaded and the estimated time remaining to complete the download.

You may cancel the download at any time. If your web connection is terminated, you will still be able to launch all course topics that have been brought down to your workstation up to that point. 

If your workstation does not have enough free disk space, a message similar to the following will appear:

 “The <Skill Builder DX> player requires X bytes of hard disk space.  You currently do not have enough free disk space. Please free up some additional disk space and then click on the download button again.”

You have the option of starting the course in a new window (outside of the web browser) as soon as the first topic has finished downloading. The new window will not include the Download option in the menu bar, because you will be using the course in an offline mode. 

After the download is complete, you can choose to leave your online session by clicking Exit on the menu bar. You can then continue your learning session in an offline mode with your downloaded content. (See Launching Skill Builder DX Courses from Your Local Workstation). 

Learning in the Skill Builder DX Environment

Starting a Topic

Each time you begin a Skill Builder DX course, the Start-up Options screen appears. If you have never launched the course before, you can begin the first unit by clicking the Start the Course option. If you have already used this course before, you can return to the topic where you left off by clicking the Continue Using This Course option.

Once you leave the Start-up Options screen, you can view the course topics in several different ways. The My Learning Track view and the Course Map view display topics hierarchically — in units, lessons, and topics. The Topic Index and Fast Track to a Topic views display topic titles alphabetically.

1. Choose the topic view that you prefer.

2. Select the title of the topic you wish to start. (In the My Learning Track or Course Map views, you may need to click on the + to expand a unit/lesson or click on the - to collapse a unit/lesson.)

3. Click the Start button that appears to the right of the title.

-or-

Click the Start Selected Topic button at the bottom of the screen.

Items that have been started will appear with a half-full dot next to the title, while completed titles will have a full dot.  Topics that have been mastered, either by Preassessment or Post Assessment, will appear with a checkmark next to the title.

Searching for a Topic

In addition to the Course Map and the Topic Index, there is another tab that allows you to quickly locate specific topics within a course. The Fast Track to a Topic tab displays an alphabetical list of course topics and a text box where you can type in a search string. A search string can be a whole word or just a few characters.

1. Display the Fast Track to a Topic tab.

2. Type in the search string.

3. Click the Search button.

For example, you want to search a Microsoft Word course for topics relating to printing a document. If you type the word “print” in the text box and then click on the Search button, all of the topics in the course that have the word “print” in the topic title will be located. To begin a new search, click the Clear Search button and type a new search string in the text box.

The topic search is not case-sensitive, so using the search strings “print” and “Print” will produce the same results. You cannot use wildcards (such as the asterisk and question mark) or Boolean logic (AND, OR, NOT) within your search string.

Note:
If you start a topic from the Fast Track To A Topic tab, clicking the Page Forward button on the last page takes you to the next topic in the unit, not the next topic in the search list.

Finding Course-Specific Help

On the Help menu, click Course Guide.

Finding Skill Builder DX Help

On the Help menu, click Quick Help.

-or-

Click on the ? button, if available.

Exiting the Skill Builder DX Learning Environment

14. Click Exit on the Menu Bar to close the Skill Builder DX learning environment window.

15. Click Yes to confirm.

Important:
Do not click the ‘X’ button in the upper-right corner of the Skill Builder DX window to exit the course. You must use the Exit menu to end your course session to allow Skill Builder DX to record your scores, bookmarking, and usage information correctly.

Customizing the Skill Builder DX Learning Environment

The User Preferences tab lets you customize some of the features of your learning environment. These Preferences can be changed as often as you like while you are in the course. Some Preferences may be unavailable if course audio is not provided or if other restrictions have been set.

16. On the Help menu, click User Preferences.

	Options
	Description

	Font Size


	This setting controls the size of the text that appears in the Control Panel window. By default, this text will display in a 10-point font. Click the Select Preferred Font Size option, then increase or decrease the text size as desired.

	Audio Play Options

(Only for courses with audio available)
	For courses with audio available, you may choose whether the audio is active. Select Audio On to play the audio while you are taking the course.  Select Audio Off to turn the audio off.

	Page Forward Options

(Only for courses with audio available)
	For courses with audio available, select the Automatically page forward option if you want to advance to the next page when the audio for the current page is finished. This feature does not work when you are asked to use the mouse or type in text on the page. If this option is disabled, you need to use the Page Forward button in the Control Panel to proceed to the next page.

	Tool Tips Display


	Select Show Tool Tips or Hide Tool Tips to indicate whether labels or other prompts are displayed when you move your mouse pointer over navigation areas of the learning environment.

	Assessment Feedback


	The default amount of information you receive following an assessment is selected when a course is installed. You may have the option of changing this setting at any time to receive feedback in lesser or greater detail.

	Emphasis Pointer Types


	Emphasis pointers appear on pages in the course to identify an area of the screen that requires particular attention. You can choose between two styles of emphasis pointers.

	Interface Themes 


	Select an option from the drop-down list to change the graphic look of the Skill Builder DX learning environment.


Please Note:  If you are using a course in Download Only mode, the Font Size, Tool Tips Display, Assessment Feedback and Emphasis Pointer Type options will appear as unavailable.  After content has been downloaded, these options will be available when using the course on your local workstation.

17. Select an option and change the setting as desired.

18. To save the setting changes and remain on the User Preferences tab, click Apply.

-or-

To save the setting changes and return to the previous view in the course, click OK.

Click the Default Settings button to restore all learning environment options to their initial (default) state. The default settings are as follows:

· Default font size (10 points)

· Full Feedback

· Audio on

· Show Tool Tips

· Simple arrow emphasis pointer

· Skill Builder DX Standard Interface (Default)

Accessibility Features

Text To Speech

Text To Speech is a screen reader feature that assists visually impaired users in navigating Skill Builder DX courses. When this feature is enabled, the Text to Speech software identifies the text, buttons, menus, and other screen objects and relays audio cues about the currently selected area. The audio cues, along with the keyboard shortcuts listed below, improve Skill Builder DX usability.

For example, when a user presses Alt + M to open the My Learning Track menu, the student will hear:

“My Learning Track. The options are Assess My Knowledge, View My Learning Track, View My Results. Use the up and down keys to select.”

Keyboard Support

Skill Builder DX provides learners with full access to screen options and menus using the keyboard.

	To navigate:
	Press:

	The Start-up Options screen
	Tab to move between the options.

Enter or Spacebar to invoke a selected option.

	The main menu bar
	Alt +<key>  (where <key> is the first letter of the menu name) to pull down the top-level menus. Press Alt + E to exit the course. Once a menu is pulled down, use the right arrow or left arrow keys to move between the top-level menus (except Exit).

Up arrow or down arrow keys to move vertically through the items in a pull-down menu. Press Enter or Spacebar to invoke a selected menu option.

In addition to the up and down arrow keys, you may press the first letter of the menu item to select it. If there are multiple menu items beginning with the same letter, continue pressing the letter to alternate the highlighted item.

	The Course Map, Topic Index, Fast Track to a Topic, Assess My Knowledge, View My Learning Track, and View My Results screens 
	Tab to move between buttons and into the shaded box

Up arrow or down arrow to move vertically within the shaded box.

Right arrow or left arrow to expand and collapse a tree structure.

Enter or Spacebar to invoke a selected option.

	The Control Panel
	Ctrl + Right arrow to move to the next page within a topic.

Ctrl + Left arrow to move to the previous page within a topic.

Tab to move between the elements on the Control Panel.

Enter or Spacebar to replay the audio (when audio button is selected).

Enter or Spacebar to activate the user link icon (when the icon is selected).

When the Page Number Indicator or Utilities menu is selected, press Enter or Spacebar to pull down the menu. Use the up arrow or down arrow to move through the pull-down menu and press Enter or Spacebar to invoke the menu option.

	The User Preferences screen
	Tab to move between the options and change the Font Size value.

Once you have tabbed to a radio button option, press Spacebar select or deselect that option.

Once you have tabbed to the Interface Options list, press Up arrow or down arrow to navigate list and press Enter or Spacebar to select a theme.

	The login screen (off-line mode)
	Tab to move between the User ID field, Password field, OK and Cancel buttons.

Enter or Spacebar to invoke the OK or Cancel buttons when selected.

	Warning messages
	Tab to move between the buttons (Yes/No or OK/Cancel).

Enter or Spacebar to invoke the selected button.


Technical Support

If you have a problem with a specific page in a course and want to report the issue, you can find the page number using the following method:

On the Help menu, click Where Am I.

The Where Am I dialog box displays the topic’s filename as well as the current unit, lesson, and topic number. Have this information available when you contact a Product Support representative.

For assistance within North America, call 800-265-1900, or send an e-mail to support@netg.com.

For assistance outside of North America, call +44 208 987 3666, or send an e-mail to support@netg.co.uk.
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